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e(fx)clipse - Anatomy

public class MyApp extends Application {
public static void main(String[] args) {
launch(args);

J

@Override

public void start(Stage primaryStage) {
BorderPane p = new BorderPane();
p.setCenter(new Button("Hello World!"));
Scene s = new Scene(p,300,300);
primaryStage.setScene(s);
primaryStge.show();
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e(fx)clipse - Runtime

Bas1ic-Runtime
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Bas1ic-Runtime

Java

Additional Layout-Panels (known from
SWT)

Dialogs similar those of SWT/JFace

FXML/Guice-Injector
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e(fx)clipse - Runtime

Bas1ic-Runtime

Java

Additional Layout-Panels (known from
SWT)

Dialogs similar those of SWT/JFace

FXML/Guice-Injector
0SG1

Equinox-Extension
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e(fx)clipse - FX+0SG1L

my.app.bundle

import java.lang
import javafx.scene

(c) Tom Schindl - BestSolution Systemhaus Gmb

Freitag, 26. Oktober 12
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my.app.bundle

import java.lang
import javafx.scene
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e(fx)clipse - FX+0SG1L

my.app.bundle

import java.lang
import javafx.scene

Adaptor Hooks
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e(fx)clipse - Adapter
Hooks

+ Defined 1n a fragment with org.eclipse.osgi as
their Host

+ Configured through hookconfigurators.properties

public class FXClassLoader implements ClassLoadingHook, AdaptorHook {

public BaseClassLoader createClassLoader(ClassLoader parent,
ClassLoaderDelegate delegate, BundleProtectionDomain domain, BaseData data, String[]
bundleclasspath) {

if (data.getBundle().getSymbolicName().equals("at.bestsolution.efxclipse.runtime.javafx")) {
// create javafx enabled classloader

J

return null;

}
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e(fx)clipse - Application
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e(fx)clipse - Application

FX-App

public class MyApp extends Application {

@Override
public void start(Stage primaryStage) {

J
J
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e(fx)clipse - Application

FX-App 0SG1-App
‘ public class MyApp implements IApplication {
public class MyApp extends Application {
@Override

@Override public final Object start(IApplicationContext

public void start(Stage primaryStage) { context) throws Exception {

} }
} }
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e(fx)clipse

Application

FX-App

F

public class MyApp extends Application {

@Override
public void start(Stage primaryStage) {

J
J

0SG1-App

public class MyApp implements IApplication {

@Override
public final Object start(lApplicationContext
context) throws Exception {

J
}

public class MyApp extends AbstractJFXApplication {

@Override

protected void jfxStart(IApplicationContext applicationContext,
Application jfxApplication, Stage primaryStage) {

}
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e(fx)clipse - Runtime

Advanced-Runtime
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e(fx)clipse - Runtime

Advanced-Runtime

Eclipse 3.x/4.x

Specialized ViewPart
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e(fx)clipse - Runtime

Advanced-Runtime

Eclipse 3.x/4.x

Specialized ViewPart

EMF-Edit integration

0SG1 + FXML
DI support for loading
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e(fx)clipse - Runtime

Advanced-Runtime

Eclipse 3.x/4.x

Specialized ViewPart

EMF-Edit integration

0SG1 + FXML
DI support for loading

ed

renderers for e4

Jemmy test support

(c) Tom Schindl - BestSolution Systemhaus GmbH

Freitag, 26. Oktober 12



e(fx)clipse - FXML

F

<BorderPane xmlns:fx="http://javafx.com/fxml" fx:controller="MyController">
<center>
<Button
text="Hello World"
onAction="#clicked" />
</center>
</BorderPane>

final MyController c = new MyController();
BorderPane p = new BorderPane();
Button b = new Button("Hello World");
b.setOnAction(new EventHandler<ActionEvent>() {
@Override
public void handle(ActionEvent event) {
c.clicked(event);

b;
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e(fx)clipse - 0SGI & FXML

System.bundle — Object.class, String.class
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e(fx)clipse - 0SGI & FXML

System.bundle — Object.class, String.class

MyApp-Bundle

(requires FX-Bundle)

MyController.class
MyControl.class
MyApp.class
myscreen. fxml
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e(fx)clipse - 0SGI & FXML

System.bundle — Object.class, String.class

MyApp-Bundle

FX-Bundle (requires FX-Bundle)
FXMLLoader.class MyController.class
Node.class MyControl.class

MyApp.class
myscreen. fxml
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e(fx)clipse - 0SGI & FXML

System.bundle — Object.class, String.class

can See can Ssee

MyApp-Bundle
FX-Bundle S e (requires FX-Bundle)

FXMLLoader.class MyController.class
Node.class MyControl.class
MyApp.class
myscreen. fxml
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e(fx)clipse - 0SGI & FXML

System.bundle — Object.class, String.class

can See can See€

MyApp-Bundle
FX-Bundle S e (requires FX-Bundle)

FXMLLOCldeI".C].ClSS —MyCOntpoller.clqss

Node.class M
yControl.class
can NOT see MyApp . cLass

myscreen. fxml
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e(fx)clipse - 0SG1+FXML

public class MyApp {

@Inject
@FXMLLoader
FXMLLoaderFactory factory;

@PostConstruct
void launch(IApplicationContext applicationContext,
Application jfxApplication, Stage primaryStage) {
Parent p = (Parent) factory.loadBundleRelative("Sample.fxml").load();
ks
ks
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e(fx)clipse - EAP

SWT-UI Core-Business-Logic

App

Services

DI-Container

EAP-SWT

Workbench Model
Eclipse 4 Application Platform

0SG1 (Equinox)

=
C
o
=
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=
O
C
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Solution
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e(fx)clipse - EAP

JFEX-UI Core-Business-Logic

App

Services

DI-Container

EAP-JFX

Workbench Model
Eclipse 4 Application Platform

0SG1 (Equinox)

=
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Solution
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e(fx)clipse - 0SG1+FXML

e4 Runtime Demo
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e(fx)clipse - 0SG1+FXML

e4 Runtime Demo

+ EMF-Ed1t
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e(fx)clipse - 0SG1+FXML
e4 Runtime Demo

+ EMF-Ed1t

+ @4 Demo
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e(fx)clipse - Real Apps
TESIS Dynaware

TESIS DYNAware simulation software in use at Audi, BMW, Ford, MAGNA,
MAN, VW and others.
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e(fx)clipse - Real Apps
TESIS Dynaware

A client-server application for vehicle dynamics
simulation , data management and animation in the
automotive 1industry.

State-of-the-art technology: 0SGi-based application using
e(fx)clipse to combine e4 and JavaFX.

TESIS DYNAware simulation software in use at Audi, BMW, Ford, MAGNA,
MAN, VW and others.
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e(fx)clipse - Real Apps
TESIS Dynaware

A client-server application for vehicle dynamics
simulation , data management and animation in the
automotive 1industry.

State-of-the-art technology: 0SGi-based application using
e(fx)clipse to combine e4 and JavaFX.

Makes heavy use of JavaFX® styling and data binding
capabilities

TESIS DYNAware simulation software in use at Audi, BMW, Ford, MAGNA,
MAN, VW and others.
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e(fx)clipse - Real Apps
TESIS Dynaware

® | TESIS DYNAware Client —~—— - e L S

—— COE ]

Home
Welcome, Susi Keep plucking that chicken. (Demo version)

Your version i up-to-date

| | Copyright TESIS DYNAware GmbH 2012

Yesterday I
6:14 pm - Audi_AS_convertible saved i
6:13 pm -Audi_AS renamed into E s

543 pm - Simulation started Project Modd Architecture \
2 days ago:

3:30 pm - Project Audi_AS saved

\i

S

i JIRA-123 Data Management Platforms
) | Create default data set for "Engine_20120731"

i JIRA-456

) | Replace component “OldEngine

i

]

e .

(c) TESIS - Dynaware ~ Copyright TESIS DYNAware GmbH 2012
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e(fx)clipse - Real Apps

TESIS Dynaware

»  TESIS DYNAware Chent

veDYNA Engine
Gasoline Engine
Diesel Engine

Power Momter

] P

Super Megs Engine

I
NRA-123
Creste default dats set for “Engine 20120731
JIRA-456
Replace component "OldEngine

© U p—S—

i —— —

) Vehicte Components |

Vehicle Components
Igmore this comment.

StandardEngine

FrontleftWheel

Copyright TESIS DYNAware GmbH 2012
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e(fx)clipse - Real Apps
TESIS Dynaware

[+ TesiS DYNAware Client — - )
(" Vehicle Components | O (7) BB ]

ARGON Help

Home ) ProjectTwo ) Vehicle Configuration Three ) TESISTruck ) Vehicle Components ) Data ltem One |

Data Item One

Ignore this comment.

»
| ‘VOata Item One | .

Data Item Two

All tems in the tem
| | Data lterm Three bar on the left are
\ draggable. Grab as

Data Item Four many as you want and

Data Item Five Here's a table of vehicle data. drop them in the
center area,
First Column Two Column Thard Column
Fust( Second 0 Third 0
Fust 1 Second 1 Third 1
Fust 2 Second 2 Third 2
I Fust 3 Second 3 Third 3 .
| Fust 4 Second 4 Third 4 If you like thes demo
= = version, do not
Fust S Second 5 Third S hesitate to buy your
e drink.
Pe Pust ] Second 7 Thurd 7
Fuct B Carnnd R 45
JIRA-123 st8 2eCONC S Third 8
i Create default data set for "Engne_20120731° Fust9 Second 9 Third 9

| JIRA-456
|| | Replace component “OldEngine”.

The dock in the

I bottom area prowdes
you with actions on
the objects of the
current page.
manual for further help
& -

TESIS - D
© ynaware Copyright TESIS DYNAware GmbH 2012
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e(fx)clipse - Real Apps
xetics MES

Flexible and Scalable Manufacturing Execution System (MES)

MES in a factory environment

ERP strategic
MES __i' tactical
ShOpﬂOOF operative
) 2 0 B ) )

<

%

Collection of machine and
process data

Life Monitoring of material
flow

Control of machine execution

Optimization of material
flow and machine settings

Reporting
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e(fx)clipse - Real Apps
xetics MES

Client/Server Architecture

£ XETICS
+ JEE © based Application
Server |
| 1 ¢
+ (Client: Eclipse4 RCP with —I—l

Ressourcen

JavaFX rendering

+ (Client and Server are \ { ,1)
extendable by Apps J%L;>

Zusammenarbeit

+ App represents a production
(MES) feature

+ Apps can be installed by
user

Protokolle Experimente
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e(fx)clipse - FX43

FX43-Desktop
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e(fx)clipse - FX43

FX43-Desktop (fullscreen)




e(fx)clipse - Runtime

fx43 sample

+ Launch application

+ Dynamically Install new app
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e(fx)clipse - MyIDE

® 00 Java - sample.osgi/src/sample/osgi/Application.java - Eclipse SDK =l
. L . : . . Q Quick Access B "M
I3 Package Explorer &2 JUni =0 (4] J1Control Java |4, Application.java 4] *Application. java 2 S0 ZEOutine 2 =0
PR packoge saomple.osgi; AR e *
A MAAUYaLw gava .
~ ) # sample.osgi
Ll »iport. oot scene.Scne & ropcato
1 messages.properties soe - JixStart(ApplicationContext, Applica
- m::':::::ph * This class controls all aspects of the JavaFX 0SGi application's execution
X o/
test.css
ba*ko‘t\s public class Application extends Abstroct)FXApplication {
b o META-INF -~ protected void jfxStart(IApplicationContext applicationContext, javafx.application.Application jfxA
{4 build.properties Scene $ =« new Scene(new Label("Hello JavaFX™));
& plugin.xml primaryStoge.
=sample.di.product a primaryStoge. © addEventFilter(EventType<T> eventType, EventHandler<? super T> eventFilter) : void - Window
sample.di.product.launch primaryStoge. @ addEventHandler(EventType<T> eventType, EventHandler<? super T> eventHandler) : void - Window
W splash.bmp primaryStoge. @ buildEventDispatchChain(EventDispatchChain tail) : EventDispatchChain - Window
v sample.osgi primaryStoge. @ centerOnScreen( : void - Window
» B JRE System Library [JavaSE-1.7) primaryStoge. ¢ close() : void - Stage
» B Plug-in Dependencies } @ equals(Object obj) : boolean - Object
v S src } ¢ evemtDispatcherProperty() : ObjectProperty<EventDispatcher> - Window
v i sample.osgi @ fireEvent(Event event) : void - Window
» J) Activator. java ¢ focusedProperty() : ReadOnlyBooleanProperty - Window
» J] Application java @ fullScreenProperty() : ReadOnlyBooleanProperty - Stage
> (2> icons @ getClass( : Class<?> - Object
» L META-INF © getEvemDispatcher() : EventDispatcher - Window
44 build.properties 4 @ getHeight() : double - Window b
& plugin.xml | @ geticons() : Observablelist<Image> - Stage :
1 sample.osgi.product Problems avadoc Decl @ getMaxHeight() : double - Stage @3 @ D.r9= 0
. sample.osgl.product.launch <terminated> at.bestsolution.fx4 @ getMaxWidth( : double - Stage
% splash.bmp DI application is a laung @ 9¢tMinHeight( : double - Stage
» & sample.osgi2 Searching for bundle: at, ® 99tMinWidth( : double - Stage
v 13> 4_advanced_osgi_samples loaded class: class at.bg ® 9¢tModalityd : Modality - Stage
v 35 > at.bestsolution.fx43.apps. hello,jl [fx Adding application: at.be @ getOnCloseRequest() : EventHandler <WindowEvent> - Window
> BAJRE System Library (JavaSE-1.7) Adding application: at.be T B Al e Press ‘~Space’ to show Tempiate Proposals
::?u:‘-m Dependencies Injection is done
- i > at.bestsolution.fx43.apps.hello. o addEventFilter
» 4} > J1App java public final <T extends Event> void addEventFPilter(EventType<T> eventType,
» 4} > JiControl Java EventHandler<? super T> eventFilter)
: "3 :2.:1 e Registers an event filter to this node. The filter is called when the node receives an Event of the specified type during the
capturing phase of event delivery.
Type Parameters:
T - the specific event class of the filter
— 3 o -
ETEM Schindl - BestSolution Systemhaus GmbH e
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e(fx)clipse - MyIDE

Q Quick Access

(J) Appicationjava  [J) *Application java &3 | = 0 3 Outline 12 =n

v ex ¥
# sample.osgi
+v© Application
. JixStart(ApplicationContext, Applica

£ Problems @ Javadoc o Decl @ getMaxHeight( : double - Stage
<terminated> at.bestsolution fx4 @ 9etMaxWidth( : double - Stage
DI application is a laung ® 9¢tMinHeight( : double - Stage
Searching for bundle: at, ® 99tMinWidth( : double - Stage

loaded class: class at.bg ® 9¢tModalityd : Modality - Stage

; ~#0O-r3i-= 0
© getOnCloseRequest() : EventHandler <WindowEvent> - Window

WIW mll(at\m- “'b., o masDabliddanh . Cosnmstiendlos sMEndoelmmtn Wl mn .
Adding application: at.be Press ‘~Space’ 1o show Tempiate Proposals
Injection is done

* addEventFilter

public final <T extends Event> void addEBventFPilter(EventType<T> eventType,
EventHandler<? super T> eventFilter)
Registers an event filter to this node. The filter is called when the node receives an Event of the specified type during the

capturing phase of event delivery.
Type Parameters:
7 - the specific event class of the filter
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e(fx)clipse - Runtime

* Resource Browsing: JavaFX-TreeView

* Compilation, Autocomplete, ... : Eclipse JDT

+ Editing: WebView (Orion-Editor with JS-Java-Bridge)
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e(fx)clipse - Runtime

JDT
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e(fx)clipse - Runtime

proposals(int offset)

Proposals as JSON
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e(fx)clipse - Runtime

WebV1iew JDT

proposals(int offset)

T-Proposal
. : Proposals as JSON
Orion-Editor
(J S) change(String content)
—

- ORGSR Compiler

Errors/Warnings as JSON

(c) Tom Schindl - BestSolution Systemhaus GmbH

Freitag, 26. Oktober 12



e(fx)clipse - Runtime

fx-1de sample

Launch IDE
Create FX-App

Open Ensemble




e(fx)clipse - Runtime

+ Credits:
+ Oxygene Icons from KDE (LGPL)
+ TESIS Dynaware
+ xeti1cs.com

+ Resources

« waw.efxclipse.org

* WAWW.bestsolution.at

« Twitter: @tomsontom

(c) Tom Schindl - BestSolution Systemhaus GmbH

Freitag, 26. Oktober 12


http://www.efxclipse.org
http://www.efxclipse.org
http://www.bestsolution.at
http://www.bestsolution.at

